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Introduction 
The following release notes describe the significant new features that are 
available in V-STARS Version 4.4.   
 
The release notes also describe many of the software fixes implemented since 
the previous release (V-STARS Version 4.3). 
 
All care has been taken to ensure that the software is functional and operates as 
it should.  This software has passed all internal testing.  Although this testing is 
thorough, it is by no means complete.  We cannot run through all the possible 
combinations and applications that our large and varied user base performs.  
We therefore urge you to try out the new features as much as possible in the next 
few weeks to confirm that they work properly.  Please notify us as soon as 
possible of any problems you find so they can be fixed in the next formal release. 
 
Throughout this guide NOTE: will be used to indicate particularly useful 
information.  Additionally, WARNING! will be used to indicate when special 
attention should be paid to the information provided to avoid an undesirable 
result. 
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Known Issues 
Opening or Importing Projects from CD-ROM or DVD 
V-STARS 4.4 will not open projects stored on a CD-ROM or DVD. Additionally, no 
files stored on a CD-ROM or DVD can be imported into a V-STARS project. This is a 
Microsoft software problem and is not a problem with the V-STARS 4.4 software. 
The workaround for this issue is to simply copy the project or files from the 
CD-ROM or DVD to the computer hard drive and open or import from there.  We 
will let you know if and when Microsoft fixes this problem. 

Thumbnail Display 
Due to a Windows limitation, V-STARS will not display more than 322 rows of 
thumbnails.  If there are more than 322 pictures in a project, all of the thumbnails 
may be displayed by expanding the width of the thumbnail display to display 
more columns.  If there is still a problem, pictures may be opened by double 
clicking the picture icons on the project tree. 
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Important Changes 
The following items are considered very important changes in V-STARS. 

M-Mode Trigger Icon Changed 
The M-Mode trigger icon has changed from a picture of a probe to the letter “T” 
(Figure 1) to better reflect what this button does, and also because a probe 
button is now used on the new M-Mode measurement type toolbar (see below).  
To help avoid confusion, the new probe button has a different appearance.   

  
Figure 1: Old Picture Bar with probe trigger icon (left). New T icon (right). 

M-Mode Measurement Type Toolbar Introduced 
GSI has added the Measurement Type Toolbar (Figure 2). This toolbar is available 
in M-Mode only and is displayed by selecting View->Measurement Type Bar from 
the V-STARS main menu. For more details see the section V-STARS M-Mode 
Features. 

 
Figure 2: M-Mode Measurement Type toolbar with new Probe, PRO-SPOT, and AutoMatch icons. 
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V-STARS INCA3 Camera Support 
The following features were added to support new INCA3 functionality. 

Wireless Interface 
Wireless capability has been added to V-STARS when using an INCA3 camera. 
The wireless interface works the same way that a wired connection works for an 
INCA camera.   
 
Pictures can be taken from the camera or from V-STARS in any combination. 
Images are acquired by pressing the trigger switch on the camera or by pressing 
the camera icon button  in V-STARS. The picture is automatically transferred to 
V-STARS and displayed in a picture window. To save the picture, simply close the 
picture window. To save the picture and take a new one, press the INCA3 trigger 
switch again or in V-STARS, press the right arrow button  on the toolbar. To 
overwrite the picture, press the camera icon button again.   
 
The Delete switch (the small red switch on the front of the camera) is used to 
delete unwanted pictures. Hold down the Delete switch until the LCD screen 
displays the delete message. Each time the delete switch is pressed and 
released, the last picture taken is deleted.  NOTE:  Deleted pictures CAN’T be 
recovered. 
 
For more information about INCA3 and wireless networking, refer to the INCA3 
Camera Manual. It explains in detail how to setup and use an INCA3 camera 
with a wireless network. 

Strobe Levels 
Inca3 cameras have an internal strobe with 
more power levels than the INCA 1 and 2. 
V-STARS 4.4 allows the user to select from 
strobe power levels 0-21 and OFF, if an 
INCA3 is connected to V-STARS (Figure 3). 
 
In addition to more levels, the INCA3 
camera has more resolution. For INCA3 the 
power doubles for every change of 3 levels 
(as opposed to the INCA1 and INCA2 
cameras in which the power doubles for 
every change of 2 levels). For example, 
level 9 is twice as powerful as level 6. 
Typically the power level is between 6 and 
12. 

 
Figure 3: Selecting INCA3 strobe level. 
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 V-STARS General Features 
Multiple Coordinate Systems 
V-STARS now supports multiple coordinate systems. The Alignment dialogs now 
have two Coordinate System fields (Figure 4). The Current field displays the name 
of the current coordinate system. The New field displays the name of the new 
coordinate system that will be created when the alignment is done. The default 
name for the new coordinate system can be changed by typing in the New 
field. 

 
Figure 4: Alignment dialog showing Current and New 
Coordinate System fields. 

 
All coordinate systems are displayed in the graphical view (Figure 5). The current 
coordinate system is displayed in color while the others are grey. The coordinate 

 
Figure 5: Multiple coordinate systems displayed in V-STARS graphical view. 
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Figure 6: Multiple coordinate systems displayed in project right-hand list 
view (left). Popup menu to change coordinate system display options 
(right). 

system name is also displayed. Coordinate systems are also listed in the 
right-hand view when the Coordinate Systems node of a 3D file is highlighted on 
the project tree (Figure 6 left). 
 
Right-click on a coordinate system in either the graphical view or list-view to 
display a popup menu with available commands (Figure 6 right). Double-click on 
an inactive coordinate system in either view to activate that system or, 
alternatively, right-click on the coordinate system and select Active from the 
popup menu. To hide a coordinate system, select it, right-click, and choose 
Hide/Show from the popup menu. To show hidden coordinate systems, right-click 
in the view and select Show All from the popup menu. Delete a coordinate 
system by selecting it and choosing Delete from the popup menu or by simply 
using the Delete key. To rename a coordinate system select the system in the list 
view. Once selected, click on the system again. A new name may then be 
entered for the coordinate system. 

Better CAD Import 

Improved IGES 
The IGES import functions have been completely rewritten to support a wider 
range of surface types. Files with both an .igs and .iges extension are imported as 
IGES files. 

VDA support 
VDA (*.vda, *.vdafs) files can now be imported to V-STARS. 

Design Point Sigmas Now Can Be Edited 
The sigmas of points in the design folder of a 3D file can now be edited directly in 
the right-hand list view. 
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Figure 7: Geomagic Qualify interface toolbar. 

Best-fit Capability Added via Geomagic Qualify 
V-STARS now supports an interface to Raindrop Geomagics’ Qualify program 
which can best-fit a cloud of points to a surface model. The use of the Qualify 
interface requires a license from GSI. Access is through the Interface toolbar 
(Figure 7) which is displayed from the View->Interface Bar menu item. 
 
Pressing the right toolbar button displays the Geomagic Qualify Setup dialog 
(Figure 8). Here, the point-to-surface fit options are set. Following is a description 
of the Setup dialog options. 

Best Fit Settings 
It is recommended that the settings in this dialog NOT be changed. 
 
Enable: This check box enables the point-to-surface best-fit in Qualify. 
 
Apply Transformation: When checked, the transformation calculated in Qualify is 
applied to the corresponding 3D file in V-STARS. 

 
Figure 8: Geomagic Qualify 
Setup dialog showing 
default settings. 

 
Sample Size: The sample size specifies the number of 
points on the surface of each object that will be 
compared during the best-fit alignment process. A 
lower number may give faster but less precise 
alignment. Typically, one should accept the default 
value.  The default value is 300 when Check 
Symmetry is checked and 1500 when Fine 
Adjustments Only is checked. 
 
Cutoff: This field is not applicable when Fine 
Adjustments Only is checked. The cutoff value 
specifies the degree of permissible error in the 
Check Symmetry phase. 
 
Check Symmetry: If checked, Qualify attempts the 
best fit alignment from several angles, not assuming 
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that the objects are already almost aligned. Then, the sample size is 
automatically changed to 1500 and a second Fine Adjustments phase is 
performed. 
 
Fine Adjustment Only: This setting specifies whether to skip the Check Symmetry 
phase. This is useful when the object is assumed to be close to correct alignment 
already. 
 
Automatic Deviator Eliminator: Checked by default, this setting enables the 
automatic removal of outliers in the best-fit. 
 

 
Figure 9: Qualify 
Trigger toolbar. 

Show Toolbar: When checked, a V-STARS Trigger toolbar is 
displayed when the Qualify program is hiding V-STARS (Figure 
9). This allows triggering without having to minimize Qualify. 
This option is checked by default. 

Starting Geomagic Qualify 
To start Geomagic Qualify, from the Start button select 
Programs->Raindrop Geomagic->Geomagic Qualify X, where X represents the 
program version number. 

Connecting V-STARS to 
Geomagic Qualify 
With Qualify running, select the 
Connect to Geomagic Qualify button 
from the Geomagic Qualify interface 
toolbar (Figure 10). The Qualify Trigger 
toolbar (Figure 9) should appear. If it 
doesn’t, switch to Qualify and select 
Macros->Enable Macro Server from 
Tools on the main menu. Then, in 
V-STARS, again select the Connect to Geomagic Qualify button. 

 
Figure 10: Connecting to Geomagic 
Qualify. 

Importing a Surface Model into Geomagic Qualify 
To import a surface model in Qualify, select File->Import from the Qualify main 
menu. From the displayed Import Files dialog box, browse to the directory where 
the surface-model file is located. Select it and click the Open button. 

Performing the Best-Fit 
With the interface configured, the left toolbar button is pressed to connect to 
Geomagic Qualify. When V-STARS is connected to Qualify, Any set points in a 3D 
data set can be sent to Geomagic to be best-fit to a surface-model. This can be 
done in either the graphical view or the points-list view of a 3D data file. To do 
this, first make sure that V-STARS is connected to Qualify as described above in 
the section Connecting V-STARS to Geomagic Qualify. Then select the points for 
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the best fit in the graphical or points-list view. Right-click and select Send 
To->Geomagic from the resulting popup menu (Figure 11). 
 
When V-STARS is connected to Qualify in M-Mode, all triangulated points are 
automatically sent to Qualify where the best-fit to the current reference model is 
performed. The transformation between the point cloud and the model 
determined by Qualify is then applied to the triangulated data set in V-STARS. 
Points can be sent manually to Qualify by selecting them in either the points list 
or graphical views and selecting Send To->Geomagic from the right-click popup 
menu. As before, these points are best-fit to the reference model in Qualify. If 
Apply Transformation is on, the resulting transformation is applied to the source 
3D data set in V-STARS. A new coordinate system is created for the newly 
transformed file as described in the section Multiple Coordinate Systems. Figure 
12 on the following page illustrates the use of Qualify to best-fit a point cloud to a 
surface model. 

 
Figure 11: Sending points to Geomagic Qualify for best-fit via the 
Send To popup menu option. 
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Figure 12: Using Geomagic Qualify to best fit a point cloud to a surface model. 
Points and model in V-STARS (top). Best fit in Qualify (middle). Points and model in V- 
STARS after best fit (bottom). 
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V-STARS S-Mode Features 
The following features are used in S-Mode measurements. 

Faster Bundle 
The bundle adjustment is now much faster than in Version 4.3.  Small bundles 
(tens of pictures, hundreds of points) are at least 2-5 times faster. Larger bundles 
(hundreds of pictures, thousands of points) are even faster (10-50 times faster). 
Bundles that previously took an entire day (and night) are now done in less than 
an hour!   
 
As part of this development, GSI created a spreadsheet to estimate the time 
required for large bundles. The spreadsheet is called “Customer Bundle Speedup 
Spreadsheet.xls” and is located in the GSI/HELP directory. To use it, just fill out the 
necessary field describing computer speed (i.e. 2GHz) and the bundle 
parameters (number of pictures, points, iterations, etc.) and it will calculate the 
estimated time for the old (Version 4.3) and new (Version 4.4) bundle. The 
spreadsheet includes an example. 

Picture Names Changed  
The picture file naming convention has changed.  This was done so that pictures 
are shown in the order they were 
taken when taking more than 999 
pictures on a job.   To do this and 
remain within the 8 character file 
name limitation of INCA pictures, the 
file names have been changed from 
Frame###.pic to Frm#####.pic. 

Updated Picture 
Information Window 
The Picture Information Window 
(Figure 13) now provides more 
information for Inca3 pictures.  It now 
contains settings of the camera at the 
time the picture was taken.  Settings 
like the exposure, strobe level, and 
other various settings are now 
available by right-clicking with the 
mouse on the picture icon or 
thumbnail and selecting Information 
from the resulting popup menu. 

 
Figure 13: Picture Information window. 

NOTE:  Pictures saved on a PCMCIA 
disk with an Inca3 camera with 
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firmware 04.08.02D and earlier will display a strobe level that is 1 value higher 
than was actually set on the Inca3 camera. For example, if the strobe level was 6 
on the Inca3 camera the Picture Information Window will display 7. In INCA3 
firmware version 4.08.02E and later, the strobe level displayed in the Picture 
Information Window is correct.   

Image Path Can Now Be Relative or Absolute 
A new feature in V-STARS 4.4 is the use of absolute and relative image paths. 
When a project is copied from its original location this new feature allows 
V-STARS to always know the correct image path. The image path is said to be 
relative when the images are directly in the V-STARS project directory or in a 
sub-directory of the project directory. The image path is said to be absolute 
when the images are located outside of the V-STARS project directory (Figure 
14). 

Figure 14: Absolute Image Path (left).  Note that images are outside of the Project Path. 
Relative Image Path (right).  Note that images are under the Project Path. 
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Scale Bar Enhancements 

Multiple Length Scale Bars 
The scale bar file format has changed to allow multiple lengths on one bar. For 
example, if there are twenty-four scales on a bar, it was previously necessary to 
have twenty-four scale bar files in the V-STARS project. Now, one file is used for all 
twenty-four scales. The new format also handles multiple length “code-aided” 
scale bars. Treatment of scale in the bundle adjustment remains unchanged. 
When running V-STARS version 4.4 for the first time, all scale bar files in the 
GSI/System directory are converted to the new format and copied to files with 
the extension sb4. The original files are retained for compatibility with previous 
versions of V-STARS. When opening a project created with V-STARS 4.3, all scale 
bar files in the project directory are converted to the new format and copied to 
files with the extension sb4. Again, the original files are retained. 

Display 
Display of scale bars is shown in Figure 15. When the ScaleBars node of the 
project tree is highlighted, a list of project scale bars and their properties is 
displayed in the right-hand list view. These consist of the bar name, number of 

 
 

 

Figure 15: Scale bar display in V-STARS. 
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lengths, material, temperature units, and calibrated temperature. When an 
individual bar node is highlighted on the project tree, the properties of each 
scale length for that bar are displayed in the right-hand list view. These consist of 
the labels of the length end-points, the distance itself, the sigma of the length 
(not currently used), and code-aided properties if applicable. 

Editing Bar Properties 
Bar properties may be edited directly in the right-hand list view (Figure 16). To 
change the bar name, click once with the mouse to select the bar (the bar 
name is then highlighted), then click a second time to open a box to perform 
the edit. To change the bar material, double click on the current bar material to 
display a dropdown edit box from which a new material may be chosen. 
Similarly, to change the temperature units, double click on the current bar 
temperature units to display a dropdown edit box from which either Fahrenheit 
or Celsius may be chosen. The calibrated temperature may be changed by 
double clicking on the current bar calibrated temperature to display an edit box 
in which the new temperature is entered. 

 

 
 

 

 
 

 

 
 

 
 

 

Figure 16: Editing scale bar properties. Renaming a scale bar (upper left). Changing bar 
material (upper right), temperature units (lower left), and calibrated temperature (lower right). 
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Figure 17: Adding a scale bar length (left) and editing new length (right). 

Managing Bar Lengths 
In the right-hand bar-length list view, new lengths can be added, deleted, 
enabled, disabled, or flagged as “code-aided”. These options are available in a 
popup menu displayed by right-clicking in the view. A new length is added to a 
bar by right-clicking in the list view and selecting New Length from the popup 
menu (Figure 17). The new length is added to the list view with point labels 
Label1 and Label2, and a distance of 0.00. These entries must be changed to 
their true values. A length is deleted by highlighting it, right-clicking, and 
selecting Delete from the popup menu. Alternatively, after highlighting the 
length, press the Delete key.  

Import Scale Bars from Text File 
Scale bars can be imported from a text file by right-clicking on the ScaleBars 
node in the V-STARS project tree view and selecting Import From Text from the 
resulting popup menu (Figure 18). This displays the Import Scalebars From Text 

 

 
 

A1 A2 27.83 
A2 A3 10.92 
A3 A4  5.09 
A5 A6 39.61 
B1 B2 48.12 
B3 B4 55.50 
B5 B6 12.27 
C1 C2 26.78 
C2 C3 14.21 
D1 D2  8.11 
D3 D4 66.43  

Figure 18: Import scale bars from text (left). File format (center). Imported 
bars (right). 
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dialog. The text file is formatted such that the data for one scale bar length is on 
one line. Each line must contain the label for the first point, the label for the 
second point, and the distance between them, separated by one or more 
spaces. Each line is imported as a separate scale bar with a single length. Each 
bar is given the default names NewScaleBar, NewScaleBar1, NewScaleBar2, etc. 
The bar name and properties can be modified after import. 

Blunders Removed From Resection 
The resection procedure can fail when one or more points have a very large 
error.  These blunders or gross errors typically occur when a point is misidentified 
or it has moved significantly (a code that has fallen off the part for example).  
What happens is these “bad point(s)” are so bad they overwhelm the good 
points and cause the bundle to fail.  V-STARS 4.4 has a new technique for 
detecting these blunders and automatically removing them so the resection 
does not fail.  Blunder points will have a red X icon next to them in the Residuals 
list of the Resect Picture dialog (Figure 19). Blunders that have been removed are 
designated by a red X icon, and do not contribute to the resection. However, 
they are included in the bundle adjustment. 
 

 
Figure 19: Resection dialog showing removed measurement blunders indicated by the red, 
X icon. 
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V-STARS M-Mode Features 
The following new features have been implemented for V-STARS M-Mode 
measurements. 
 
Keyspan Remote Trigger 
 

 
Figure 20: Keyspan remote 
(left) with USB RF receiver. 

V-STARS now support a radio remote trigger (from 
Keyspan) which does not have the line of sight 
limitations of our earlier IR based remotes (Figure 
20). The remote trigger interfaces via a USB port 
and its range is typically 33 feet (10 meters).  Its 
primary use in M-Mode is to trigger a 
measurement.  However, the remote can also be 
used to delete the most recent probe 
measurement and act as a remote mouse. 
 
NOTE: Use of the remote requires key coding 
software that must be installed and run on the 
computer.  This is done on any computers GSI 
provides.  To install the Radio Remote on another 
system, please refer to the Geodetic Systems 
guide entitled, Installation of Keyspan Remote. 
 
To setup the Keyspan Remote for use in M-Mode, do the following: 
 

1. The USB receiver must be plugged into the computer’s USB port 
2. V-STARS must be in M-Mode 
3. The Remote Trigger option must be on in the M-Mode dropdown menu 
4. The remote must be in Media Mode.  Press the Media Mode Button; it 

should turn green for a few seconds and then blink green regularly to 
indicate it is in Media Mode.   
 
NOTE:  If the Media Mode button does not light up when pressed, the 
remote may be broken or the battery may be dead.  Replace the 
battery and try again.   If it still fails, replace the remote.   

 
When in Media Mode, pressing the blue Trigger button at the top of the remote 
will trigger the cameras.  The last probe point can be remotely deleted by 
pushing the delete button (see Figure 20) into the up or forward position. V-STARS 
will first display a message to confirm the delete. Confirm the point delete by 
pushing the delete button into the down or back position. To cancel the delete, 
simply push the delete button in the up or forward position. 
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The remote can also function as a mouse. The circular button directs the cursor 
movement while the rocker button beneath it acts as a left and right click 
button. 
 
NOTE:  The remote will exit Media Mode after about four minutes of inactivity.  
Pressing the Media Mode button will immediately take the remote out of Media 
Mode (so avoid doing this).  Pressing any other button will keep Media Mode 
active.   
 
Troubleshooting NOTES:    
 
If V-STARS doesn’t respond, make sure the USB device is plugged in, the Remote 
Trigger flag is on, and that the remote is in Media Mode (is the Media Mode 
button blinking green?).  If there is still no response, try pointing the remote at the 
receiver (although the device is radio based it still helps to have a clear path 
from transmitter to receiver).  If this is still unsuccessful, the device may be out of 
range; move closer to the receiver and try again.  If the range is the problem, try 
moving the notebook closer, or use a USB extension cable to place the receiver 
closer to the transmitter.  If the range is less than normal, try replacing the 
battery.   
 
If the trigger fails to operate, try using the remote mouse.  If the mouse does not 
work, try replacing the USB receiver.  If the mouse works, try pressing CTRL-SHIFT-
ALT-F5 (press all four keys down simultaneously).  If the cameras trigger, the 
remote is not working properly in Media Mode.  Try re-programming the remote 
(see the Installation of Keyspan Remote Guide).  If it still fails, try another remote. 
 
M-Mode Measurement Type Toolbar 
 
The V-STARS M system is an increasingly versatile measurement tool.  One can 
measure using individual targets, coded targets, multiple hand-held probes, Pro-
Spot, and Feature Targets.  In addition, there are different ways to measure 
individual targets.   Moreover, it may be necessary to perform all of these tasks 
within a single V-STARS project and to quickly alternate between them.   Finally, 
some of these tasks can be done at the same time, and some cannot. To make 
all this power and versatility easier to manage, GSI has added the Measurement 
Type Toolbar (Figure 21). This toolbar is available in M-Mode only and is displayed 
by default. The toolbar can be hidden or re-displayed by selecting 
View->Measurement Type Bar from the V-STARS main menu. 
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Figure 21: Toolbar button description (left). Displaying the M-Mode Measurement 
Type toolbar (right). 

As of the 4.4 release, the toolbar consists of three icons for probe, PRO-SPOT, and 
AutoMatch measurements respectively. Now, the desired measurement type 
can often be set by just pushing the appropriate buttons on this toolbar.   
 
NOTE: A Probe and Pro-Spot can’t be used at the same time. Also, Pro-Spot and 
AutoMatch can’t be used at the same time.  Therefore, the Toolbar will not allow 
these combinations. 
 
NOTE Pro-Spot Measurement: When Pro-Spot is first selected for measurement, if 
there are no projectors in the project, the Select Projector(s) dialog is displayed, 
allowing the user to import a projector.   Even if there is only one physical 
projector, the software treats each projector with a different slide as a projector 
and it is necessary to select which one is currently being used. 
 
Helper Points in M-Mode 
 
Sometimes in M-Mode the distribution of control points may be deficient in 
number or location for a variety of reasons. There may be few places on a rigid 
permanent structure to place control points, temporary physical obstructions 
may block some control points, or the user himself may hide some control points 
when probing. So-called helper points can help in many of these situations. Right 
now, coded targets must be used for helper points (in the future other types of 
targets will also be used). To use helper points, place the helper targets at useful 
places in the scene. These points should help surround the area of measurement 
when possible. Like control points they must be stable during the measurement 
but unlike control points XYZ coordinates are not needed. So they can be put on 
stable places as needed. The other requirements are that the codes must be 
unique (no duplicates and not in the driver file), and the codes must be seen by 
both cameras. Helper points are used in the Unstable Camera Orientation 
procedure when the Helper Points box is checked in the M-Mode Setup Dialog 
(Figure 22). When the Unstable Camera Orientation is performed, coded targets 
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that are seen in both images and are NOT in 
the driver file are triangulated and added to 
a new driver file called, by default, 
Helper_Driver.3D. 

 
Figure 22: Helper Points check box 
in M-Mode Setup dialog. 

PRO-SPOT Speed, Reliability, 
and Setup Improved 
 
The speed and reliability of PRO-SPOT in M-
Mode has been improved. Additionally, the 
projector setup is simpler. The Projector 
Match Setup Dialog is shown in Figure 23. 
The dialog has settings to Label Points by 
Epoch, Create Log File, a Planes Filter and 
Surface Projection Filter. 
 
The Planes Filter speeds up the process of 
projecting points to model surfaces by eliminating any points on defined planar 
surfaces other than the object of interest. The planes must be defined in the 
driver file and be labeled Plane1, Plane2, etc. Points that project to any of these 
planes within the Tolerance value shown are not projected to model surfaces. 
 
If the Surface Projection Filter is on, points that don’t project to a model surface 
within the Surface Tolerance are not written to the resulting triangulation file. 
 
If Label Points by Epoch is on, the label of each PRO-SPOT point in the 
triangulation file includes the epoch number. It is necessary to label points by 

epoch to avoid duplicate 
point labels when merging 
several triangulation files. As 
an example, PRO-SPOT point 
1075 in epoch 30 would be 
labeled _S30_1075. 

 

 
 

Figure 23: PRO-SPOT Projector Match Setup Dialog. 

 
The Create Log File option, 
on by default, is used for 
diagnostic purposes. The log 
file is written to the Projector 
sub-directory of the current 
V-STARS project. The file 
name includes the epoch 
number. For example, the file 
written for epoch 30 is named 
ProjectorMatchLog_Epoch30.
txt. 
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V-STARS Bug Fixes 
 
The following bugs have been fixed in V-STARS 4.4 
 

• Apparent instability in Unstable Camera Orientation fixed. It is important to 
note that the results of the procedure were always correct although the 
display of the residuals was incorrect. There was no detrimental impact on 
any subsequent measurements. 

• Previously, all scale bars in a V-STARS project were written to the file 
Outstar.txt whether they were used or not. Now, only those scale bars that 
are actually used are written to the file. 

• When subsampling in the bundle, scale bar points might not have been 
included in the adjustment. Scale bar points are now always included. 

• Cameras with different filenames but identical names within the camera 
file could be imported into the V-STARS project causing the bundle to 
crash. A check has been added to prevent the import of cameras with 
duplicate names. 

• Fixed bug in the Circle, Sphere, and Cylinder Fits that would cause the 
offset to be applied incorrectly.   

• Fixed bug in the Save As Template Project function that would incorrectly 
save the project file if the name of the project was changed.  

• Fixed bug in the 3D Line Follow Rename function. Previously, the function 
would automatically be called if two points were renamed. 

• Auto Contrast bug fixed where Level 2 contrast was identical to Level 1 
contrast. 
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